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Introduction 
 
This document is intended to provide guidance on how to identify accessibility issues found in 
Microsoft Word and Portable Document Format (PDF) documents. This guide is for Personal 
Computer (PC) users, however links to helpful information and resources for Macintosh (MAC) 
users is provided at the end of the document.   
 
First, it is recommended that, when possible, a user should address accessibility issues before 
transforming a document into a PDF. This approach is beneficial to all users, but it is particularly 
helpful for those who not have Adobe Acrobat Pro and the accessibility tools available through this 
software. With this in mind, this guide will provide instructions on how to identify accessibility 
issues in Microsoft Word (2016 version), a commonly used application that is used to create PDFs, 
as well as in Adobe Acrobat Pro DC (2020 version).  This document also provides examples on how 
to address accessibility issues in Microsoft Word, as well as additional resources for users interested 
in learning more.1 
 
There are a number of ways in which a user can transform a source document (e.g., Microsoft word) 
into a PDF however, not all methods transfer accessibility features equally. As a result, the method 
selected will impact the amount of accessibility features which are successfully transferred.2 The best 
option is to use Abode Acrobat software. PDFs were originally created by Adobe Acrobat and as a 
result Adobe Acrobat is one of the best tools to use when transforming a source document 
(e.g., Microsoft Word) with accessibility features into a PDF. However, Adobe Acrobat Pro requires 
a monthly subscription and users may not have access to this software. If a user does not have 
access to Adobe Acrobat Pro other methods can be utilized which have been shown to keep most 
accessibility features through the transformation process. For example, if the source document is in 
Microsoft Word the user can save the document as a PDF, transferring many of the accessibility 
features. While the user can be assured that most accessibility features established in Microsoft 
Word will be transferred to the PDF, the only way to confirm and detect remaining issues would be 
to run an additional accessibility check on the document. Free accessibility checkers are available, 
however no one particular free resource is recommended. Most importantly, there is no guarantee 
that these free accessibility tools are able to identify all remaining accessibility issues. In fact, no 
matter what checker tool is used (free or paid), there are some issues that will always require manual 
review and correction.  One method that can be used to create a PDF document that is discouraged 
is the use of the Print option. When printing a document, there is an option to print as PDF 

 
1 Both software applications provide accessibility tools that help users meet the accessibility standards of Section 508 of 

the Rehabilitation Act and the Web Content Accessibility Guidelines (WCAG) 2.0 Level AA.  WCAG standards and 
Section 508 were developed to address the accessibility needs for a range of users including the blind, D/deaf, hard of 
hearing, those with low vision, limited movement, speech disabilities, photosensitivity, select learning disabilities and 
cognitive limitations. 

2 For example, different sections of a document should have different tags depending on the content. Tags identify 
either content is a heading, subheading, paragraph, list, table, feature etc.  These tags also need to be in the correct 
order to be read properly by assistive technology (e.g., screen reader). Depending on what method of transformation is 
used, some or most of this information may be lost.  
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(Microsoft Print to PDF).  This method is discouraged because it often results in the loss of 
structure tags or other information needed for accessibility. 3  
 
The following section describes how to check for accessibility issues in Microsoft Word, presents 
four common examples of accessibility issues, and ways to address them.  
 
Detecting Accessibility Issues in Microsoft Word 
 
Once a document is finalized, a user should run the Microsoft Accessibility Checker.  While the 
Microsoft Accessibility checker won’t detect all problems (again, some issues require manual review), 
it does identify many accessibility issues and provides information on why certain issues create 
accessibility barriers and how to address them. Using the Microsoft Accessibility Checker is a useful 
resource in ensuring many accessibility issues have been addressed before saving as a PDF and is 
recommended for all users, including those with Adobe Acrobat Pro.  
 
In order to run the Microsoft Accessibility Check, the user must first go to File, Info, Check for 
Issues/Inspect document (See Figure 1) and then select Check Accessibility (not pictured).  
 

Figure 1. Check for Accessibility Issues 

 
 
A dialog box titled Accessibility Checker: Inspection Results will appear on the right side of the 
screen. Accessibility issues in need of attention will be listed under Errors, Warnings, and Tips 
(See Figure 2 for an example of accessibility inspection results). Errors are the most serious issue 

 
3 Structure tags identify the structure and different components of a document. 
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and represents content that is difficult to read or understand for people with accessibility needs. 
Warnings are less serious but do make the document harder to read. Tips represent content that 
can be understood but may be an issue and can be presented in a different way. 
 
By clicking on the different errors, warnings, and tips, the user will be taken to the specific location 
of the accessibility issue in the document. The Inspection Results dialog box also provides additional 
information addressing accessibility issues and are labeled Why Fix and How To Fix (See Figure 2). 
In addition, at the very bottom of the Inspection Results dialog box users will find a link to an 
additional resource labeled Read more about making documents accessible.  
 
Warnings, errors, and tips will vary based on the document content. The Microsoft Accessibility 
checker detects and provides guidance on how to fix a range of issues related to formatting 
(e.g., headings), alternative text for images, table structure, columns, lists, legible text size, adequate 
contrast and more.4  
 
The following section provides four examples of common accessibility issues and a brief description 
of how address them. Links to additional information is provided at the end of the document under 
Additional Resources.  
  

 
4 For a list of errors, warnings and tips go to: https://support.microsoft.com/en-us/topic/rules-for-the-accessibility-
checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1 

https://support.microsoft.com/en-us/topic/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/topic/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
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Figure 2. Accessibility Checker Inspection Results 

 

Example 1: Missing Alternative Text 
 
When a document includes pictures, tables, figures, or other images alternative text must be included 
in order for the images to be accessible by assistive technologies like screen readers. Alternative text 
entails providing a brief description of the image. If alternative text has not been added, an 
accessibility checker will report an error of Missing Alt(ernative) Text. One way to resolve this 
issue is to locate and select the image in the document and click the right button on the mouse 
(right click). From the listed options, the user should go to Format Picture, then Layout and 
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Properties. A box will appear and about halfway down the dialogue box the user will find the Alt 
Text heading and below that a space to add a Title and Description (see Figure 3). Adding a title 
and accurate description of the image will resolve the accessibility error for that image. In the 
instance that a document already has alternative text, it is beneficial to review the alternative text to 
confirm it accurately describes the image. The accessibility checker can only detect if information is 
provided or not, it cannot confirm if the information is accurate or appropriate. This must be done 
manually.   
 
Another area that often needs manual checking is color contrast. Text should have a contrast ratio 
of at least 4.5:1 except for large text (contrast ratio should be 3:1), incident text or images (purely 
decoration) or logotypes (text that is part of a logo or brand name). Resources for assessing color 
contrast are provided in the Additional Resources section. Users must be able to identify the specific 
RGB color code of text in order test contrast.  

Figure 3. Format Picture – Alt Text 
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Example 2: Tables with No Header Row Specified 
 
It is recommended that tables be as simple as possible (avoid merging, splitting or nesting cells) and 
to avoid using tables for formatting content or layout purposes. Once a table is inserted in the 
document), the user needs to specify the header row. This specification allows assistive technology 
like a screen reader to identify the content and the location of the cursor.   
 
For example, Figure 4 presents a simple table presenting contact information for three individuals. 
In order to make this table accessible, the user must confirm the header row is identified and this 
can be done with the table tools feature.  

 

Figure 4. Table Example Presenting Individual Contact Information 

Name Address City  State Zip 
Joe Smith 12 Broad St. Central City FL 12345 
Adam Rowe 433 Washington Ave. Northern City DE 33224 
Sara Jones 798 Main St.  Southern City CA 112233 

 

In order to check the table features, the user should select the table and click on the Design under 
Table Tools in the menu bar at the top of the page (see Figure 5).    

 

Figure 5. Table Tools and Design 

 
 

Once in Design tools, the user can select which columns and rows they want to have formatted 
(See Figure 6). Make sure that there is a check in the box labeled Header Row within the Design 
tools menu.   
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Figure 6. Confirm Checked Box Next to Header Row 

 

 

Another important step is to enable the header row across pages. In order to do this the user should 
go to Table Properties (right click on mouse to pull up options) and make sure to check the option 
Repeat as header row at top of each page (see Figure 7). This indicates the header and allows the 
header to repeat if the table stretches across multiple pages.  

 

Figure 7. Check Box Repeat as Header Row at Top of Each Page 

 
Finally, this table needs alternative text. In order to add alternative text, select Table Properties, 
and a dialogue box will open. From the dialogue box options, select Alt Text tab and insert a title 
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and description (See Figure 8). The level of detail of the description will depend on the information 
being presented in the table.   

Figure 8. Alternative Text for Table 

 
 

Example 3: Repeated Blank Space   
 
Repeated Blank Space or Characters is a warning that can be addressed by removing space or 
adding formatting features. Figure 9 provides an example repeated blank characters identified by the 
accessibility checker. As indicated on the right-hand side of the picture, 18 blank characters have 
been identified. If the user clicks on the 18 characters warning (in blue), the blank characters will be 
identified with a gray bar in the document (see underneath text).  This is extra space which can be 
removed using the by deleting this space. If space in built into the body of the document, the user 
should remove the blank space using formatting tools (e.g., adjusting spacing options for before 
and/or after paragraphs).    
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Figure 9. Example of Repeated Blank Space 

 

Example 4: Headings and Logical Reading Structure   
 
Headings are an important part of navigating a document and indicates to assistive technology, 
such as screen readers, the structure of the content. Main headings can be identified as Heading 1, 
and subheadings identified as Heading 2, and Heading 3 (See Figure 10). Heading levels should not 
be skipped.  For example, Heading 2 should follow after Heading 1 and not before.  

Figure 10 shows an excerpt of the first page of this document with the heading “Introduction.” 
In order to identify the word Introduction as a heading, the user should highlight the word (or 
phrase) and when in Home tab, the user can select Heading 1. The user can also select Heading 2 
or Heading 3 if the word or phrase represents a subheading. This option can also be selected by 
clicking on the References tab, then clicking on Add Text and selecting from Level 1, Level 2, or 
Level 3 (not pictured). The style and size of the font may change when identifying words or phrases 
as heading but these changes can be adjusted from the Home tab (font type, size, color etc.). 

Figure 10. Example of a Heading 
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Saving Document as PDF 
 
The Microsoft Accessibility Checker is not able to identify all of the accessibility issues in a 
document (for a full list of Microsoft Accessibility rules see link in Additional Resources).  
For example, while the Accessibility Checker is able to detect some issues with color contrast, it is 
not able to detect issues where color alone is being used to convey information. As mentioned earlier, 
even if some images have text, it is important to review all descriptions and verify they are accurate. 
The Accessibility Checker cannot detect if the description of an image is accurate or not. Finally, the 
user will need to manually review heading structure, color contrast, formatted lists, descriptive link 
text, logical reading order and more. To learn more about manual review see links provided in the 
Additional Resources.  
 
Once errors, warnings, and tips have been addressed, the user can go to File, Save As, and under 
Save as type change from Word Document (*.docx) to PDF (*.pdf).    
 

Figure 11. Save as PDF 
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When the user changes Save as Type from Word to PDF an Options button will appear in the 
Save As dialog box (see Figure 11 above). The user should click on the Options button to be 
presented with an Options dialog box. Confirm the Document structure tags for accessibility is 
checked. This is the feature that will transfer structure tags into the PDF document (e.g., tags that 
identify header, subheading, paragraph, table, figure, lists etc.). After confirming this option is 
clicked, the user can click OK in Options box and then click Save in Save As box.  Once these 
steps are completed a PDF will be created.    

Figure 12. Document Structure Tags for Accessibility  

 

 
When saving a Word document as a PDF many accessibility features will transfer, however, the 
process does not guarantee that all accessibility features will be transferred. Access to Abode 
Acrobat Pro provides additional features for the user to identify remaining accessibility issues and 
guidance on how to address them. The following section summarizes the accessibility features in 
Adobe Acrobat Pro DC.  

For Users with Adobe Acrobat Pro DC 
A user will be able to address many accessibility issues in Adobe Acrobat Pro however, as 
mentioned earlier, it is recommended to try to address as many of accessibility issues as possible in 
the original document source (e.g., Microsoft Word) before transforming into a PDF document. 
There are a number of reasons for this including that some accessibility issues are easier to address 
in the source document. In addition, if the PDF document ever needs to be recreated, the user will 
have the benefit of addressing accessibility issues in the source document. Any accessibility issues 
addressed in the PDF would have be re-addressed in the new version of the PDF document.5  

 
5 With Adobe Acrobat Pro, there are features that allow the user to automatically fix accessibility issues. There are pros 

and cons to utilizing this feature depending on the content of the document. See Additional Resources for links to 
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Once the user has addressed all accessibility issues as possible in Microsoft Word there are two 
common ways a PDF can be created.  

Option one: Open document in Microsoft Word, go to File, and select Save as Adobe PDF 
(See Figure 13).  

Figure 13. Save as Adobe PDF 

 

 

Option two: Open Adobe Acrobat Pro, go to File, then Create, Create from File, locate the 
source document in the correct folder on the computer and select Open (see Figure 14). There may 
be a brief wait as the document is being transformed into a PDF (cursor will turn into a small clock). 
Once the process is complete, the PDF document will automatically show up as a new tab.   

 

 

 

 

 

 

 

 
accessibility features in Adobe Acrobat Pro. In addition, the ability to edit a PDF may depend on the security features 
associated with the document and may be limited to the author of the source document.  
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Figure 14. Create from File 

 

 

Accessibility Components   
 
An Accessibility Tool is available with Adobe Acrobat Pro DC and should be listed among the 
various tools on the right-hand side of the screen.  
 
If the Accessibility Tool is not listed, click on the Tools tab, scroll down to the Protect & 
Standardize section, find Accessibility and click Open (see Figure 15).  
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Figure 15. Adobe Acrobat Pro DC Tool Selection 

 

 

Once Accessibility Tool is available open, return to the new PDF document.  On the right side 
among the various tools, find and click on Accessibility. Once Accessibility is selected a list of 
features will be presented on the right-hand side to the screen (See Figure 16). 
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Figure 16. Adobe Accessibility Tools 

 

 

Click on Accessibility Check and a box with appear with a range of Options (See Figure 17).6  
In general, the user will not need to change any of the automatic features. If desired, the user does 
have the option of running an accessibility check on a select number of pages instead of the full 
document (See: page range). Unless the user has a particular preference, all categories (8) should be 
checked. The user can begin the assessment by clicking on Start Checking (See Figure 17). 

 

 
6 Under Report Options, if “Create accessibility Report” is checked, will automatically create a web-based accessibility 

report and the user can designate which folder or location to save the report. 
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Figure 17. Accessibility Checker Options 

 

 

The results of the Accessibility Checker will show up on the left-hand side of the screen and the 
list of accessibility issues fall into a range of areas including: Document, Page Content, Forms, 
Alternative Text, Tables, Lists, and Headings (See Figure 18). 

The Accessibility Checker can guide the user through each of the issues and can provide five 
different types of notifications: Passed (item is accessible), Passes Manually (item was marked as 
passed by user based on manual inspection), Skipped by User (rule was not selected in the Options 
section by the user), Needs Manual Check (item needs to be manually inspected), and Failed 
(Item is not accessible).  
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Figure 18. Accessibility Check Issues 

 

 

Below is a summary of accessibility standards. Please see links for more detailed information in 
Additional Resources.  

Document 
• Document should include tags  

o Logical reading order: needs manual check after tags are added 
• Missing title in title bar 
• Color Contrast (readability): Needs manual check for 4.5:1 contrast ratio 

Page Content  
• Page content and annotations should be tagged 
• Tag order should be consistent with structure order (logical reading order) 
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Alternative Text 
• Pictures, clip art, figures, tables, and graphics should include alternative text (or should be 

labeled as decorative so they will not be identified as content) 
• Other issues regarding alternative text 

Tables 
• Tables should be identified properly and include headers and a summary 

Lists 
• Lists should be identified properly 

Headings 
• Headings should be nested property (e.g., identified as main heading or subheading)  

Links 
• Should have an unambiguous name that describes the destination, function or purpose of 

the link 
 

Features for Resolving Accessibility Issues 
 
Adobe Acrobat Pro provides guidance on how to fix areas that have failed the accessibility checker 
review.  First, the user can right click on any issue or item listed in the left-hand side of the screen 
under Accessibility Checker and a dialogue box will pop up. This will provide options to Fix, Skip 
rule, Explain, Check Again, Show Report, and Options. 
 
Fix: Selecting Fix will present the user with the option for Adobe to automatically fix the issue or 
the user will be presented with a dialog box in order to fix the item manually. Once the issue is 
addressed, the item will be labeled Passed.  

Skip Rule: Selecting Skip Rule will mean this item will not be reviewed for accessibility issues. Once 
selected the item will be labeled Skipped.  

Explain: Selecting Explain will take you to an Acrobat Abode Resources for addressing different 
PDF accessibility issues and will describe why different issues are considered accessibility barriers 
and provide guidance on how to resolve each issue.  This resource (link provided in Additional 
Resources section) also includes links to WCAG web resources for each issue.  

Check Again: Selecting Check Again re-runs the accessibility checker on all items.  

Show Report: Selecting Show Report will present the report with links to tips on how to address 
failed items.  

Options: Selecting Options opens the Accessibility Checker Options dialog. If needed, the user can 
review which checks were selected and performed.  

Depending on the content of the document, some accessibility issues will be easier to address than 
others. As mentioned earlier, there are accessibility issues that require manual review and include 
verifying logical reading order, and color contrast between foreground and background.  Links to 
color contrast checkers have been provided in the Additional Resources section. If users have the 
ability to open a PDF in a Chrome browser, they can add a Chrome Extension named ColorPick 
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Eye Dropper that can be used to identify specific color RGB codes. These codes can then be 
entered into the color contrast ratio to identify if they color contrast meets the 4.5:1 ratio.  

One final note, while a user does not have to be an expert in order to address many accessibility 
issues, it is important to ensure that all accessibility issues are detected and successfully resolved. 
Depending on the complexity of the document, identification and resolution of accessibility issues 
may require consultation with an expert.  
 
Additional Resources 
 
Microsoft Resources 
Improve accessibility with the Accessibility Checker: https://support.microsoft.com/en-
us/topic/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-
5ad801426c7f 

Rules for the Accessibility Checker: https://support.microsoft.com/en-us/topic/rules-for-the-
accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1 

Microsoft Word- Creating Accessible Documents (WebAIM): 
https://webaim.org/techniques/word/ 

Everything you need to know to write effective alt text: https://support.microsoft.com/en-
us/topic/everything-you-need-to-know-to-write-effective-alt-text-df98f884-ca3d-456c-807b-
1a1fa82f5dc2 

Adobe Resources 

Adobe Accessibility Standards Overview: https://www.adobe.com/accessibility/508standards.html 

Using the Acrobat Pro DC Accessibility Checker:  

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html 

https://www.adobe.com/accessibility/products/acrobat/using-acrobat-pro-accessibility-
checker.html 

Create and Verify PDF Accessibility (Acrobat Pro) 

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html 

W3C Resources  

PDF techniques for WCAG 2.0: https://www.w3.org/TR/WCAG20-TECHS/pdf 

PDF Technology Notes: https://www.w3.org/TR/WCAG20-TECHS/pdf_notes.html 

Section 508 Resources 

GSA Government-Wide IT Accessibility Program:  https://www.section508.gov/ 

Modules on Creating Accessible PDFs: https://www.section508.gov/create/pdfs 

https://support.microsoft.com/en-us/topic/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f
https://support.microsoft.com/en-us/topic/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f
https://support.microsoft.com/en-us/topic/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f
https://support.microsoft.com/en-us/topic/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/topic/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://webaim.org/techniques/word/
https://support.microsoft.com/en-us/topic/everything-you-need-to-know-to-write-effective-alt-text-df98f884-ca3d-456c-807b-1a1fa82f5dc2
https://support.microsoft.com/en-us/topic/everything-you-need-to-know-to-write-effective-alt-text-df98f884-ca3d-456c-807b-1a1fa82f5dc2
https://support.microsoft.com/en-us/topic/everything-you-need-to-know-to-write-effective-alt-text-df98f884-ca3d-456c-807b-1a1fa82f5dc2
https://www.adobe.com/accessibility/508standards.html
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://www.adobe.com/accessibility/products/acrobat/using-acrobat-pro-accessibility-checker.html
https://www.adobe.com/accessibility/products/acrobat/using-acrobat-pro-accessibility-checker.html
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://www.w3.org/TR/WCAG20-TECHS/pdf
https://www.w3.org/TR/WCAG20-TECHS/pdf_notes.html
https://www.section508.gov/
https://www.section508.gov/create/pdfs
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Color Contrast Checkers 

Web Accessibility in Mind: https://webaim.org/resources/contrastchecker/ 

Color Contrast Checker –Acart Communications: https://contrastchecker.com/ 

For MAC users 

Creating Accessible Word and PDF Documents – MAC Users (Carleton University): 
https://carleton.ca/edc/teachingresources/accessibility/creating-accessible-word-and-pdf-
documents-mac-users/ 

Understanding Document Accessibility-Microsoft Word for Mac 2011, 2016, and 2019 (Ryerson 
University, Pressbooks): https://pressbooks.library.ryerson.ca/docs/chapter/microsoft-word-2011-
mac/ 

 

https://webaim.org/resources/contrastchecker/
https://contrastchecker.com/
https://carleton.ca/edc/teachingresources/accessibility/creating-accessible-word-and-pdf-documents-mac-users/
https://carleton.ca/edc/teachingresources/accessibility/creating-accessible-word-and-pdf-documents-mac-users/
https://pressbooks.library.ryerson.ca/docs/chapter/microsoft-word-2011-mac/
https://pressbooks.library.ryerson.ca/docs/chapter/microsoft-word-2011-mac/
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